
Introduction
The Print Label program helps you print simple labels on your printer (dot matrix recommended).    The 
program completely bypasses windows and prints directly to the hardware.    You can specify how many 
labels you want, an incremental counter (for a serial/asset number), the number of lines between labels, 
number of lines per label, etc.    The label always prints in the printers current font and size.

You are prompted for the contents of the label and other information about the output format.    You may 
also indicate how many labels you want to print and the starting number for a sequential counter.

Anywhere you want to print the current counter number simply include the two characters ^C (caret and 
capital C).    This string will be replaced by the current counter number (which is incremented between 
each label).
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Saving and Restoring a Label
Saving a Label Format
Print Label allows you to save the current label format and all the additional parameters (label size, 
sequential counter, etc.) for later use.

Select Save or Save As from the File menu.    You are prompted for the file name you want to save the 
current label format to.    The file should have the extension ".LAB" to make it easier to find later.

Restoring a Label Format
Print Label allows you to open a previously saved label format and all the additional parameters (label 
size, sequential counter, etc.)..

Select Open from the File menu.    You are prompted for the file name you want to open.    By default all 
files with the ".LAB" extension are displayed for you to select.

Opening an existing label overwrites the current label format.    Please remember to save the current 
label if necessary.

Allow the label to be wider than the imput field.    Use the scroll bars to see more of the label.

Changed the display font to a non-proportional font for easier alignment of label contents.



Registration
You have a 15 day evaluation period in which to try out the package.    If you use it longer than 15 days 
you must license/register it.    The reminder screens will not appear once you have registered the 
software.

How to Register

You can register by mail or electronically via CompuServe's Software Registration Service.    It is strongly
recommened that users outside the US register electronically as it can be much less expensive.
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Contacting Pride Software Works!
Questions or comments about our software or services?    Need to Register?    Contact:

CompuServe ID: 73337,2472

Mail:

Pride Software Works!
Department 45
6 Sedley Ct.
Greensboro, NC 27455
                                            USA



License Agreement
Print Label is not and never has been public domain software, nor is it free software.    You are, however,
granted 15 day evaluation period to try out the system.

The software product and user's manual are copyrighted and all rights are reserved by Pride Software 
Works! and Charles L. Cranford IV.

Evaluation users are granted a limited license to use Print Label for no more than 15 days for the 
purpose of determining whether Print Label is suitable for their needs. The use of Print Label for more 
than 15 days    requires licensing and the payment of a license fee. The use of the product for more than 
15 days by any person, business, corporation, government agency, or any other entity without licensing 
it from Pride Software Works! is strictly prohibited.

A license permits a user to use Print Label on any single computer, or, in a LAN environment, on one 
workstation.    The software may not be installed on more than one workstation or single user computer 
without additional licenses.

No one may modify or patch the Print Label files in any way, including but not limited to decompiling, 
disassembling, or otherwise reverse engineering the program.

A limited license is granted to copy and distribute Print Label for the trial use of others, subject to the 
above limitations, and to those below:

(1) Print Label must be copied in unmodified form, complete with the file containing this license 
information and all documentation.

(2) Print Label may not be distributed in licensed form to any person.    It MUST be distributed as an 
unlicensed copy.

(3) No fee, charge, or other compensation may be requested or accepted for distributing Print Label, 
except as follows:

(a) operators of electronic bulletin board systems may make Print Label available for 
downloading. A time-dependent charge for the use of the bulletin board is permitted so 
long as there is no specific charge for the download of any Print Label files.

(b) vendors of Shareware may distribute Print Label, subject to the above conditions, and 
may charge a disk duplication and handling fee, not to exceed ten dollars.



Warranty
Pride Software Works! guarantees your satisfaction with this product for a period of thirty days from the 
date of original license. If you are dissatisfied with Print Label within that time period, return the package 
in salable condition to Pride Software Works! for a full refund. 

Pride Software Works! warrants that all disks provided are free from defects in material and 
workmanship, assuming normal use, for a period of thirty days from the date of purchase.

Pride Software Works! warrants that Print Label will perform in substantial compliance with the 
documentation supplied with the software product. If a significant defect in the product is found, the 
Purchaser may return the product for a refund. In no event will such a refund exceed the license price of 
the product.

The product and all updates are provided on an "as is" basis without warranty of any kind, express or 
implied, except as stated above including, but not limited to the implied warranties of merchantability or 
fitness for a particular purpose. The entire risk as to the selection, quality, results, and performance of 
the product is with the Licensee. Should the product prove defective, then the Licensee (and not Pride 
Software Works! or its dealers) assumes all liability and expense incurred as a result thereof. Some 
jurisdictions do not allow the exclusion of certain implied warranties so in such jurisdictions, the above 
exclusion of implied warranties may not apply to you. The limited warranty gives you specific legal rights.
You may also have other rights which vary from jurisdiction to jurisdiction.

Pride Software Works! shall have no liability or responsibility to you or to any other person or entity with 
respect to any liability, loss or damage caused or alleged to be caused directly or indirectly by the 
product or your use, misuse or inability to use the product, including but not limited to, any interruption of
service, loss of business, anticipatory or actual profits or consequential damages resulting from the use, 
misuse or inability to use the product.

Pride Software Works! does not warrant that the functions contained in the product or updates will meet 
your requirements.

Use of this product for any period of time constitutes your acceptance of this agreement and subjects 
you to its contents.



Update History
Version 1.0 Released 8/7/93

Version 1.5 Released 8/29/93
Ability to save and restore label formats (along with the label size, sequential counter, etc.).
Reorganized the window to make it easier to use.
Added support for a sequential counter (for inventory/asset labels etc.)

Version 1.6 Released 10/24/93

Version 1.7 Released 12/18/93
Improved error messages - they now contain details about what caused the error.
The new menu option Search Help... has been added to the Help pulldown menu.    This item 

displays the keyword search dialog.

Version 1.8 Released 2/27/94
Switched from CMDIALOG.VBX to CSDIALOG.VBX.    It was installed with the update.    You may 

need to copy it to the Windows System directory.



Registering via CompuServe
If you are a member of CompuServe, you can register this Pride Software Works! application 
electronically.    This is much faster than the mail and is the perfered method for registering users outside
the US.    When you use the CompuServe Software Registration system your CompuServe account will 
be charged for the registration fee (see opening message box) plus a 15% processing charge (to cover 
the cost of CompuServe charging your account and mailing payment to us).    You must be a member of 
CompuServe to use this registration option.

Log into CompuServe using your assigned account number and password.
Go to the SWREG menu (type GO SWREG at the ! prompt) or use your CIM to go there.
Select menu option "Register Software".
Select menu Option "Search By Registration ID"
Enter registration ID 1819 when prompted.
A description of the application displays.    Notice that the registration fee is 15% higher than that 

displayed in the product.    This slight increase in registration fee covers the cost of CompuServe charging
your account and mailing payment to us.

You are prompted "Would you Like to Register?" - Respond Y.
Your CompuServe account is charged the registration fee indicated (in US dollars).

You will be sent the required activation information via CompuServe eMail shortly.

IMPORTANT: Do not delete the .REG file or re-install the software after you send us your serial 
number.    Doing so assigns a new serial number to the product and the activation key sent to you will 
not work.

Activating the Application



Registering by Mail
Install the software per the instructions.
Start the software.    You are prompted for some information (company name, your name, day 

phone number, and CIS ID (optional).    This information must be accurate as it will be sent to us as part of
your registration.

When the opening information window appears, press the "Print Registration Form" button.    The 
registration form will print to the default printer in the printer's default font.

Fill in the remaining blanks on the form.    Be sure your CompuServe (CIS) ID is specified (if you 
are a member of CompuServe).    The activation key will be sent to you via CompuServe eMail.    If you 
are not a member of CompuServe your activation key will be mailed to you.

Mail your payment for the license fee listed on the form to the address below.    Remember to 
make payment payable to Charles Cranford.    Payment must be in US funds ( a check drawn on a US 
bank, Money Order or Bank check in US funds, etc.)

IMPORTANT: Do not delete the .REG file or reinstall the software after you print the registration form.   
Doing so assigns a new serial number to the product and the activation key sent to you will not work.

WARNING: Pride Software Works! has discovered that some companies outside the United States are 
accepting registrations for our products.    Since they can not provide you with a activation key the 
program will not be fully activated.    Only Pride Software Works! can accept and process your 
registration key.

Pride Software Works! Mailing Address

Activating the Application



Activating the Software
After you receive your activation key:

After you receive your activation key you need to enter it into the application to register the application.    
This will eleminate the registeration reminder windows and remove any other limits that existed in the 
unregistered version.

Start the software.
When the opening information window appears, press the "Register" button.    The registration 

information you entered before displays.    You are prompted for your Activation Key which has been 
supplied to you by Pride Software Works!.

Enter the key supplied to you into the box, double check it, and click on OK.    If the key is correct 
the system will be registered.

Exit the program now and simply restart the program to continue using it.    The registration 
reminder screens will never appear again.

The registration information is stored in a file with the .REG extension.    Do not delete this file (as you 
must again register the software).    Future updates will not affect this file so you may install them without
worrying about your registration.    We suggest you make a backup of this file so that in the event of 
computer problems you do not have to re-register the software.



Obtaining Updates
Updates to Pride Software Works! shareware products are always free of charge.

In order to provide you with updates to Pride Software Works! software as quickly as possible (while also
controling our cost and passing the savings on to you), updates are released on the CompuServe 
Information Service.    If you are a member of CompuServe you may download an update at any time.    
GO IBMFF and search for files contributed by 73337,2472.

If you are not a member of CompuServe, you may be able to locate updates to our products on local 
BBS services or on CD ROM shareware collections.    We also distribute our software through shareware
libraries, although all titles may not be available from all libraries.

If none of these channels is available to you, you can order a set of diskettes with the latest versions of 
all Pride Software Works! shareware titles directly from us.    Send $3 ($6 for orders outside the US,    in 
US funds) for shipping and handeling.    We will send you a set of 3" HD Diskettes with our shareware 
titles.    There is no gareentee that this application has been updated since you aquired it.

Before applying an update, check the version information carefully.    "Downgrading" to a lower version 
may cause problems with the application.

Note: Applying and update to your registered system has no effect on your registration status.    You will 
not need to obtain a new activation key.

Pride Software Works!



CompuServe Information Service
CompuServe is an international computer network.    Although Pride Software Works! is not directly 
afliated with this service, we do use it for distributing updates to our shareware and handeling support 
questions through eMail.    If you are interested in obtaining more information about this service you can 
contact CompuServe directly.    Tell them that Charles Cranford at 73337,2472 recomended you.

Free CompuServe Sampler (provided by CompuServe and is subject to change without notice)
CompuServe offers a free sample of its services.    With a modem and one of COmpuServes modem 
phone numbers, log into compuserve with user ID    77770,101.    Try 2400 baud and settings E71 or 
N81.        You may need to press [Ctrl-C] after connecting.    The password is FREE-DEMO.    Enjoy!

How to Reach CompuServe (provided by CompuServe and is subject to change without notice)

United States

Telephone:
Tollfree within United States: 1-800-848-8990
Outside of United States: 1-614-457-8650

Hours of support:
8:00am - 12:00am (EST) M-F
Noon - 10:00pm (EST) Weekends

Address:
CompuServe
5000 Arlington Centre Blvd.
P.O. Box 20212
Columbus, Ohio 43220

Fax:
Inside USA: 1-614-457-8149
Outside USA: 1-614-457-8149

-------------------------

Argentina

Telephone:
Within Argentina: 
01-372-7817        
01-372-7871        
01-372-7883

Outside Argentina: 
(+54) 1-372-7817        
(+54) 1-372-7871        
(+54) 1-372-7883

Hours of Support: 
9:00 am - 6:00 pm    Weekdays

Address:
CompuServe S.A. Argentina
Av. Rivadavia 969 2do. P. Frente



Buenos Aires, 1002 Argentina

Fax:
Inside Argentina: (01) 372-7825
Outside Argentina: (+54) 1-372-7825

Australia/New Zealand

Telephone:
Freephone within Australia: 008 023 158
          Hours: 7:00 am - 7:00 pm (Australia) EST

Freephone within New Zealand: 0800 441 082
          Hours: 9:00 am - 9:00 pm (New Zealand) ST

Outside Australia and New Zealand: (+61) 2 410 4260

Address:
Fujitsu Australia Ltd.
475 Victoria Avenue
Chatswood, NSW    2067 
Australia

Fax: 
Inside Australia: (02) 410 4223
Outside Australia: (+61) 2 410 4223

Chile

Telephone:
Within Santiago Metropolitan Area:    696-8807
All other cities within Chile:    (02) 696-8807 
Outside Chile: (+56) 2-696-8807

Hours of Support: 
9:00 am - 5:00 pm    Weekdays

Address:
Chilepac
Gerencia Red de Datos
Morande 147
Santiago, Chile

Fax: 
Inside Chile: (02) 696-1474
Outside Chile: (+56) 2-696-1474

Germany



Telephone:
Freephone within Germany: 0130-86-4643
Outside Germany: (+49)(89) 66 55 0-222
 
Hours of Support: 
9:00 am - 8:00 M-F

Address:
CompuServe
Jahnstrasse 2
DW-8025 Unterhaching bei Munchen
Germany

Fax:
Inside Germany: (089) 66 55 0-255
Outside Germany: (+49)(89) 66 55 0-255

Hong Kong

Telephone:
Within Hong Kong: 867-0102
Outside Hong Kong: (+852) 867-0102

Hours of Support:    
9:00am - 6:00pm M-F
9:00am - 12:00pm Sat.

Address:
CompuServe Hong Kong
Hutchison Information Services, Ltd.
30th Floor, One Pacific Place

88 Queensway
Hong Kong

Fax:
Inside Hong Kong: 877-4523
Outside Hong Kong: (+852) 877-4523

Hungary

Telephone:
Inside Hungary:
(1) 156-5366

Outside Hungary:
(+36) 1-156-5366

Hours of Support: 
9:00am - 5:00pm    Weekdays



Address:
CompuServe Hungary
Microsystems RT.
1122 Budapest XII
Varosmajor u. 74
Budapest, Hungary

Fax:
Inside Hungary:    (1) 155-9296
Outside Hungary:    (+36) (1) 155-9296

Israel

Telephone:
Within Israel: (03)-290466
Outside Israel: (+972) 3-290466

Hours of Support: 
9:00am - 5:00pm Sunday-Thursday

Address:
CompuServe Israel
Trendline Information and Communications Services, Ltd.
22 - Yavne Street
Tel-Aviv Israel

Fax:
Inside Israel:    (03) 200419
Outside Israel:    (+972) 3-200419

Japan

Telephone:
Tollfree within Japan: 0120-22-1200
Outside Japan: (+81) 3-5471-5806

Hours of Support:
9:00 am - 7:00 pm (JST) Weekdays
9:00 am - 5:50 pm (JST) Saturday

Address:
NIFTY Corporation
8th Floor, Omori Bellport A,
Minami-Oi 6-26-1, Shinagawa-ku
Tokyo 140 Japan

Fax: 
Inside Japan: 03-5471-5890 or 5891
Outside Japan: (+81) 3-5471-8590 or 5891



Korea

Telephone:
Freephone within Korea: 080-022-7400

Outside Korea: 
(+82) 2-569-5400
(+82) 2-569-1542
(+82) 2-569-1544

Hours of Support:
9:00am - 7:00pm    weekdays
9:00am - 5:50pm    Saturday

Address:
PC Communication Department
POSDATA CO., LTD
10th Floor, Daehan Jedang Bldg.
7-23, Shinchun-dong, Songpa-ku
Seoul, Korea

Fax:
Inside Korea: 02-569-6988
Outside Korea: (+82) 2-569-6988

South Africa

Telephone:
Inside South Africa:
(012) 841-2530
0800-112252

Outside South Africa:    (+27) 12-841-2530

Hours of Support:
9:00am - 5:00pm    weekdays

Address:
CompuServe Africa
P.O. Box 72668
Lynnwood Ridge
South Africa
0040

Fax:
Inside South Africa:    12-841-3604
Outside South Africa: (+27) 12-841-3604



Switzerland

Telephone:
Freephone within Switzerland: 155 31 79
Outside Switzerland: (+49)(89) 66 55 0-222 
    
Hours of Support: 
9:00 am - 8:00 M-F (CET)

Taiwan

Telephone:
Within Taiwan: 02-651-6899
Outside Taiwan: (+886) 2-651-6899

Hours of Support:
9:00 am - 6:00 pm (TST) M - F

9:00 am - 12:00 pm (TST) Saturday

Address:
Taiwan Telecommunications Network Svcs. Co., Ltd.
Far East ABC Intelligent Science Park
1st Floor, No. 13, Lane 50, Nan-Kang Road
Section 3
Taipei, Taiwan R.O.C.

Fax:
Inside Taiwan: 02-651-1801
Outside Taiwan: (+886) 2-651-1801

United Kingdom

Telephone:
Freephone within U.K.: 0800 289458
Outside U.K.: (+44) (+272) 760680

Hours of Support: 
9:00 am - 9:00 pm M-F (London Time)

Address:
CompuServe Information Service (UK) Limited
1 Redcliff Street
P.O. Box 676
Bristol BS99 1YN

United Kingdom

Fax:
Inside UK: 0272 252210
Outside UK: (+44) 272 252210



Venezuela

Telephone:
Inside Venezuela:
02-793-2384
02-791-8694

Outside Venezuela:
(+58) 2-793-2384
(+58) 2-781-8697

Hours of Support: 
8:00am - 5:00pm    Weekdays

Address:
CompuServe C.A. Venezuela
Plaza Venezuela - Torres Capriles
Piso 4, Oficina 401
Caracas - Venezuela

Fax:
Inside Venezuela:    (02) 793-1952
Outside Venezuela:    (+58) 2-793-1952

Other

If there is no local Customer Service listing in your country, please try contacting the Customer Service 
office nearest you or calling CompuServe Customer Service in the United States for further assistance.

Pride Software Works! expresses no warranty or other claims for CompuServe and provides this 
information as a public service.




